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1. Introduction 

 

System Requirements 

• Intel© Pentium 4 or a similar Processor 

• 512 MB RAM 

• 10 MB of free HD space 

Operating System 

BrightCore BACnet Lookout was tested and working with the following operating systems 

• Microsoft Windows XP 

• Microsoft Windows Vista 

• Microsoft Windows 7 
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BrightCore BACnet Lookout is the newest addition to our BrightCore line of products. It is an 

easy-to-use tool which enables you to scan, discover and generally manage your BACnet networks.  

BACnet Lookout is not just an ordinary BACnet explorer through which you can monitor or read 

properties. It also enables you to build your specified property monitor and COV lists and later save or 

load them back in to the program.  You can detect alarm and event states on specified devices through 

GetAlarmSummary and GetEventInfo BACnet services and list them in user friendly and easy-to-read 

format. It also enables you to export your BACnet network to EDE format and use it later in your own 

product or application.  

 

  

 

Figure 1. Overview of BACnet Lookout communication 
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2. Setup 

 

Start the installation by double clicking the “BrightCore BACnet Lookout setup.exe” 

You must accept EULA license agreement before continuing. 

 

 

 

Figure 2. EULA 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



BrightCore BACnet Lookout   V2.2 Product Family  

 

© ELMA KURTALJ ltd.                            BrightCore BACnet Lookout v2.2 

September 2013 

Page 8 

 

You will be prompted to select destination folder (Figure 3.) 

 
NOTE: The install target directory must have reading and writing rights for the current logged user. 

             If you don’t have such rights, contact your system administrator.  

 

 

 

Figure 3. Setup, step 1 

Select the destination folder and click “Next” button. 

 

You can also create a Start Menu folder by disabling “Don’t create a Start Menu folder” 

(see Figure 4.). Click “Next” to continue. 

 

 

 

Figure 4.   Setup, step 2 
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Select if you want to create a desktop icon and Quick Launch icon. 

 

 

Figure 5. Setup, step 3, 

Press “Next” button. 

 

 

Figure 6. Setup, step 4 

 

Confirm your options by pressing “Install” button. 
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Figure 7.  Installing 

 

 

Complete the installation process by pressing “Finish” button. If you enabled automatic launch of 

BACnet lookout, application will start as soon as you click “Finish” button. 

 

Figure 8.   Setup, step 5. 
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3. Licensing and Register options 

 

After initial launch BACnet Lookout will notify you of days left in the trial run. If you purchased the 

application, copy-paste the Registration Number and send it to licensing@brightcore.biz along with your 

full name and company from a valid e-mail address.  

 

 

Figure 9.  Licensing and Register Options 

After receiving your unlock code click on the Register tab or a button and input your username and 

Unlock code into their respective fields. 

 

Figure 10. Register Window 
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4. User Interface 

 

 

Figure 11. BACnet Lookout User Interface 
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BACnet Lookout user interface main sections. 

Toolbar and system menu 

 

Toolbar and system menu are the main methods of communication and management with the BACnet systems. 

Every option enables in one way or another to communicate and gather information on the BACnet device.  

The options are in order: 

  Who Is BACnet service.  - Scan and discover the BACnet network. 

  Subscribe to property COV. – Receive the change of property value. 

  Get Alarm Summary BACnet Service. – Receive and view the device list of alarm states. 

  Write Property BACnet Service. – Writes one or more BACnet properties. 

  Empty Write List. – Undo the changes made. 

  Show Alarm Summary List. – View device list of alarm states. 

  Show COV List. View received COV list. 

   Show Monitor Property List. – View the monitored property list. 

   Property Stress Test 

 



BrightCore BACnet Lookout   V2.2 Product Family  

 

© ELMA KURTALJ ltd.                            BrightCore BACnet Lookout v2.2 

September 2013 

Page 14 

 

Device Tree List  

                            

                                                              Figure 12. Simple and structured view device list. 
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Device Tree List  

Device Tree Lists consists of 2 different tree views accessible by click the Tab Buttons above them. They 

are simple and structured device Trees.  

This 2 device tree lists will always have the same devices shown but using the structured tree view will organize 

the device list by its Data Link Layer, Network number and Object type. 

Both Tree Views contain the list of discovered BACnet devices on the BACnet network. It is also a control part of 

the application meaning all services and options presented in the Toolbar or System menu work in combination 

with the Device Tree List.  

Toolbar and System menu options works only when an appropriate device, object or a property is selected in the 

Device Tree List. 

Device Tree List is also designed around fast Object/Property discovery. Double clicking the Object/Property will 

automatically discover member objects of the device or properties of the object. 

Objects and properties are automatically discovered using ReadProperty or ReadPropertyMultiple BACnet services 

without bothering the operator with intrinsic BACnet options. 

Additionally, when the application detects that the property “PROPERTY_OBJECT_NAME” is discovered it will 

automatically put the name by the object instance in the Device Tree List as seen in example on the left:  “Device , 

1 , New Virtual Device 1” depending whether or not this option is chosen in the settings. 
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Property Value List 

 

Figure 13. Property Value List 

Property Value List is the heart of the BACnet Lookout.  

Every object property of selected BACnet device or object is automatically displayed in this list each time the 

selection changed in Device Tree List.  

Properties are presented in the user friendly format so the operator can change it as fast as clicking the mouse 

button. 

 

Example.  

We want to change the Bit 0 of PROP_EVENT_ENABLE from value 0 to 1. We can do that just by clicking the 

checkbox value next to the Bit[0].  After that we change PROP_BUFFER_SIZE from 10 to 20 and press enter.  

It is as simple as that. 

 

But it is important to mention that although it appears property values are now changed, they still need to be 

written to the BACnet device. Clicking the “Write Property BACnet Service” option in the Toolbar will actually write 

the values to the selected BACnet device. 
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System Information 

 

Figure 14. BACnet Information 

 

BACnet and system message window tabs are the operators window on what happens with the application or the 

device. These messages are separated by BACnet and System tabs and as they state, they will convey BACnet or 

System specific messages. 

 

Some samples of BACnet specific messages would be failure to write property or acknowledgement of write, 

unknown service error or similar messages. 

 

 

System specific messages convey the information important to operator concerning the inner working of the 

application.  System specific errors will be shown here. For instance APDU data of some BACnet message was not 

coded properly or the format of some property was not set.  

 

Below the System Message window is a System Information bar. The bar shows current system information. 

• Current BACnet Lookout version 

• Link Layer Protocols currently in use 

• Current device ID of incremental scan. 

• Information about Property Monitor system with the time remaining until next property scan when 

Property Monitor is enabled. 
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5. Configuring BACnet Lookout 

 

Before any work can be done it’s necessary to configure the application to the system. 

Click on the Edit menu and select the Settings option. The configuration window will appear. 

 

 

Figure 15. General Settings 

 

General settings. 

• Read Object List Properties Delay. 

- While BACnet Lookout offers a fast Object/Property Discovery by double clicking there’s always a 

possibility that device has hundreds if not thousands of object. Clicking through all of them to 

find a specific one or simply to have them all discovered can be a pretty time consuming task.                                          

BACnet Lookout offers automatic scan of selected device object list by one click. This option 

controls the how fast each object is scanned. The delay is presented in milliseconds. 

• Polling Interval. 

- BACnet Lookout also can be configured to scan different properties by inserting them in to the 

internal Property Monitor List. This option controls a time delay between each property scan. 

Time delay is presented in milliseconds. 
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• BACnet Port. 

- Not every device operates on the same port number. Although the industry standard BACnet 

port is 47808 (convenient hexadecimal BAC0) engineers and system engineers can decide to 

change the port of the device for whatever reason. This option allows operators to scan BACnet 

networks working on a different port. This option requires application restart. 

• Enable Property Monitor. 

- Enables or disables internal Property Monitor. 

• Send Who-Is on start. 

- This option is automatically enabled when application is started for the first time. It scans the 

network for BACnet devices automatically each time the application is run and also at each new 

project. Operators may choose to disable this option when building their own user networks 

where only specific devices are present. 

• Use Read Property Multiple as default read. 

- Device Tree List offers a quick-object/property scan by double clicking on the object /property 

and it uses ReadPropertyMultiple BACnet service by default. This is convenient because it 

discovers every property currently present in the BACnet object. Including unknown and 

proprietary properties. But not all devices support ReadPropertyMultiple BACnet service. 

Disabling this option will force BACnet Lookout to use ReadProperty BACnet service as a default 

read service. This will also scan object properties, but only the standard object properties and 

proprietary properties will have to be added manually by operator and then saved as a specific 

device project to avoid having to repeat the process. 

• Show Object Name/Description. 

- When dealing with hundreds of BACnet devices or objects it is often useful to have a device or 

object name beside only type and instance. Enabling this option will name the device/object in 

the Device Tree List each time the application detects that object name or description property 

was discovered. 

• Enable Notification Event Listener.  

- This option will force the application to register and monitor Notification Events issues from the 

device. 

• Use Array Index When Scanning Properties 

- This option will force the application to read properties by its array index. Use it when the object 

list is too big and device doesn’t support segmentation. 
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Figure16. Communication Options 

 

• BACnet/IP 

- Standard BACnet/IP communication link layer. Enable this option for devices communication 

through BACnet/IP communication protocol. 

 

• BACnet/Ethernet 802 

- Not all devices can communicate in BACnet/IP protocol and some devices can only receive and 

transmit packets in somewhat older Ethernet802 communication protocol. Although BACnet/IP 

and BACnet/Ethernet802 both communicate  on the same network layer, the BACnet messages 

are fundamentally different. BACnet Lookout also offers a way to communicate with those kind 

of devices.  

- To set up the Ethernet interface select it from Ethernet Drives Interface drop-down list.                                    

When Current Ethernet Driver Interface shows the selection click OK.                                                    

This option requires application restart. 

• BACnet /MSTP (Standard and extended versions )  Enable this option to find devices operating on MSTP 

RS485 protocol. 
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Figure 17. MSTP Settings 

MSTP Options are standard RS485 wire configuration options. Reply Delay and Reply timeout control how long in 

milliseconds the application will wait until it receives the answer from the device. 

Output MSTP Traffic to Wireshark (Extended Version only) will enable you see MSTP BACnet traffic as regular 

packets in Wireshark. You need to enter the pipe name and create the same pipe in wireshark. 

To do this start Wireshark and click on the Capture menu and select Interfaces option. Click the options button and 

then click Manage Interfaces button. Click the new button and enter the pipe name. 

Pipe name must be written in this format: “\\.\pipe\pipename”. Where pipename is the same as the one you 

specified in BACnet Lookout. Click on save and close. You should see this window. 
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6. Using BACnet Lookout 

 

Discovering BACnet Device List 

The first thing any operator will want to do is to discover BACnet network.  

Usually the application will always send a default WHO-IS service every time it starts but sometimes the operator 

can decide to disable that option and manually scan the network. Be it to create a new network project or just to 

scan the specific device range.  

To manually scan the BACnet network go to the Edit menu and select the Settings option. Now disable the  

Send WHO-IS on start option. Click OK and go to the File menu and select New option. When prompted with 

saving the project, click NO. 

Empty project will appear. And now the Device Tree List will be empty. 

Click on the Who-Is Network Scan option in the Toolbar menu represented by the transmitting radio tower icon. 

 

 

 

Figure 18. Who Is selection window 

On the window shown in the Figure 17, input desired IP network, device scan range and click Start. 

Alternately you may want to do the incremental network scan. This will allow you to scan the network in a 

specified device range but instead issuing one huge WHO-IS service, issue a lot of smaller services in the same 

range but with smaller increment.  

For example, doing an incremental scan in a device instance range 0-1000000 with increment of 100 would  look 

like this: WHO-IS 0-100, WHO-IS 100-200, WHO-IS 200-300 etc. 

If the scan was successful, a list of devices will now display in the Device Tree List. 
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Discovering BACnet Object List  

There are two ways to find objects and properties of listed devices.  

First one is to just double click on the device listed and BACnet lookout will automatically initiate a ReadProperty 

BACnet service. It will simply ask the parent device for its list of objects. And then will automatically construct the 

object list in the Device Tree List.  

 

It is important to note here that sometimes the engineers can make a mistake and create hundreds of object on 

the same device but do not check the device’s segmentation options. This can result in an error when trying to 

construct the object list. We ask the device for an object list and receive “Segmentation Not Supported Error”. 

 

This can be countered by enabling “Use Array Index When Reading Properties” option in the General Settings 

dialog window. 

 

 
Figure 19. Device Object List 
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Discovering BACnet Object Properties  

After successfully reading its object list, object properties can be read the same way, by double clicking BACnet 

object.  

BACnet Lookout by default uses ReadPropertyMultiple BACnet service when reading properties of selected BACnet 

object. This is convenient because not only is it extremely fast and bandwidth efficient, it also discovers every 

property currently present in the BACnet object including, unknown and proprietary properties.  

But not all devices support ReadPropertyMultiple BACnet service.  Sometime when device doesn’t support 

ReadPropertyMultiple BACnet service it is required to scan the properties using ReadProperty service. 

This will also scan the object properties but unknown and proprietary properties will be excluded from the list.                  

Operator can then use BACnet Lookout internal Add Property option to manually add proprietary properties. 

Right click on the selected BACnet object and choose Add Property option from the drop down menu. 

 

Figure 20. Add New Property Window 

If proprietary property input window is empty chosen BACnet standard property will be added to the selected 

object. If property input window has a number, choose a property data type and click Add button. 

Newly created property will then be added to the object’s property list. Operator can then double click on the 

property to retrieve its value.  
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Changing Property Value and working with the Property List 

 

Every object property of selected BACnet device or object is automatically displayed in this list each time the 

selection changed in Device Tree List.  

Properties are presented in the user friendly format so the operator can change it as fast as clicking the mouse 

button.  

 

 

Figure 21. Property List 

Properties in the property list are represented in two different ways. There are simple properties representing only 

the basic and one-click-edit values, such as integer, text, float… And the array properties, such as supported 

services, supported types, bit values and others. 

The third type representations are complex properties such as week days, object references and such. 

 

 

 

In addition to writing simple properties there are more complex properties  that can’t be changed by simple line 

change. This are complex properties and BACnet Lookout will show an appropriate popup window for each 

property type that will enable the value change. 

 

This properties can be recognized by the text line in the property list saying “Click here to edit items”.  

It is important to note here that not all complex properties can be changed as some complex properties are read-

only properties and other depends on the device configuration.  

 

 Below are some examples of complex property windows. 
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Figure 22. Changing the destination property of the Notification Class Object. 

 

 

Figure 23. Object Property Reference. 
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Figure 24. Weekly Schedule property. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

It is important to mention that although it appears property values are now changed, they still need to be written 

to the BACnet device. Clicking the “Write Property BACnet Service” option in the Toolbar will actually write the 

values to the selected BACnet device. 
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Figure 25. Write Confirmation Window 

Clicking the Write Property BACnet Service button will prompt the operator with the window displayed in the 

figure 21. 

 

Each changed property will be displayed on this list enabling the operator to change the priority of each write 

command.  

Clicking the Confirm button will then try to write each property in the list using the BACnet WriteProperty service. 

But not all of the properties in the device can be changed. Some will be Read-Only and some will be device-specific 

Read-Only properties.  

 

If the write command fails for specific properties, System Messages window will display an appropriate BACnet 

error-class  and error-type.  
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7. BACnet Services 

 

BrightCore BACnet Lookout supports several BACnet services. 

• Read Property*   

• Read Property* 

• Write Property* 

• Get Alarm Summary 

• Subscribe COV Property 

• Create Object (Standard and Extended Versions ) 

• Delete Object(Standard and Extended Versions ) 

• Time Synchronization 

• Time Synchronization UTC 

• Read Broadcast Distribution Table ( Extended Version ) 

• Write Broadcast Distribution Table ( Extended Version ) 

• Register Foreign Device Object ( Extended Version ) 

• Read Foreign Device Table ( Extended Version ) 

• Write Foreign Device Table ( Extended Version ) 

• Delete Foreign Device Table Entry ( Extended Version ) 

 

 

* This services are incorporated in to the application functionality and cannot be accessed directly. 
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Get Alarm Summary 

The GetAlarmSummary service is used by  a client BACnet-user to obtain a summary  of "active alarms." 

The term "active alarm" refers to BACnet standard objects that have an Event_State property whose 

value is not equal to NORMAL and a Notify_Type property whose value is ALARM.  

 

To receive the list of active alarms, BACnet device must support GetAllarmSummary service. 

When request is initiated the list of active alarms will display in the Alarm Summary List property 

window. 

The list is color-coded for easier reading and is as follows: 

Alarm: Number   - List of Alarm Summaries for a specific device. 

Alarm Summary: number – 1…n Alarm summaries for specific device. 

OID  - Object type, Object instance of object in alarm state. 

Event State - Event state of offending object. 

Transition Bits – Transition Bits of offending object. 

 

 

 

Subscribe COV Property 

The SubscribeCOVProperty service is used by  a COV-client to subscribe for the receipt of notifications of 

changes that may occur to the properties of a particular object. Any object may optionally support COV  

reporting. If a standard object provides COV reporting, then changes of value of subscribed-to 

properties of the object, in some cases based on programmable increments, trigger COV notifications to 

be sent to one or more subscriber clients. Typically, COV notifications are sent to supervisory programs 

in BACnet client devices or to operators or logging devices. 

 

To Initiate a COV subscription, right-click on the property and under Services menu choose 

SubscribeCOVProperty option. The following dialog will appear. 
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Figure 26. Subscribe COV Property 

 

Issue Confirmed Notification option tells the COV server device weather to automatically re-subscribe 

to the property if the change occurs in the device or lifetime expires.  

To cancel the subscription, uncheck Issue Confirmed Notifications and enter 0 at the Lifetime option. 
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COV Notification List 

 

Figure 27. COV Notification List 
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Create/Delete BACnet object  

The CreateObject and DeleteObject services are used by a client BACnet-user to create or delete a new 

instance of an object. This service may be used to create or delete instances of both standard and 

vendor specific objects. The standard object types supported by this service are specified in the target 

device PICS file. 

 

 

 

Figure 28. Create Object 

 

Time Synchronization and UTCTimeSynchronization services. 

The TimeSynchronization and UTCTimeSynchronization services are used by  a requesting BACnet-user 

to notify a remote devices of the correct current time so that they may synchronize their internal clocks 

with one another. 
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9. Tests9. Tests9. Tests9. Tests        

 

As of 2.0.1.5 version BACnet Lookout supports Device Stress tests. (Standard and Extended Version ) 

Read Property Stress Test 

 

Figure 29. Read Property Stress Test Window 

Read Property Test is designed to enable few of the common tests normal BACnet device should 

support.  

To test the property, right click on the property in the Device Tree to open up a context menu and then 

select “Test->Stress Tests->ReadProperty” option or select the property and click the Read Property Test 

button in the Toolbar. This will bring up the window shown on Figure 24. 
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9. Features 

 

Objects supported (all properties in listed objects supported).

Objects 

Analog Input 

Analog Output 

Averaging 

Binary Input 

Binary Output 

Binary Value 

Command 

Device 

File 

Group 

Life Safety Point 

Life Safety Zone 

Loop 

Multi State Input 

Multi State Output 

Multi State Value 

Pulse Converter 

Notification Class 

Program 

Calendar 

Event Enrollment 

Schedule 

Trend Log 

Structured View 

Load Control 

Trend Log Multiple 

Access Door 

Event Log 
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Objects supported (all properties in listed objects supported).

                  Read                   Write
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Objects supported (all properties in listed objects supported). 

Write 
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Here is the list of supported 

 

Application 

Discover Objects

Discover Properties

Read Property 

Write Property 

BACnet/IP 

communication Data 

Link 

Property Monitor

Alarm Summary List

Event Summary List

Subscribe COV 

Property 

Import EDE 

Export EDE 

IEEE 802.3 Ethernet 

communication Data 

Link 

Time Synchronization

Structured Device List

UTC Time 

Synchronization 

BACnet/MSTP Data 

Link Layer 

Create Object 

Delete Object 

Property Stress Test

Read Broadcast Table

Write Broadcast Table

Register Foreign 

Device 

Read Foreign Device 

Table 

Delete Foreign Device 

Entry 

Analyze MSTP Traffic
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Here is the list of supported features for BACnet Lookout 
 

BrightCore 

Bacnet Lookout 

Essential 2.2 

P/N BBLe-1 

BrightCore 

Bacnet Lookout 

Standard 2.2 

P/N BBLs-2 

BrightCore

Bacnet Lookout

Ex

P/N BBL

Discover Objects   
Discover Properties   

   
   

communication Data   

Property Monitor   
Alarm Summary List   
Event Summary List   

  

  

  
IEEE 802.3 Ethernet 

communication Data   

Time Synchronization   
Structured Device List   

   

BACnet/MSTP Data 
  

  

  
Property Stress Test   

Read Broadcast Table   
st Table   

Register Foreign 
  

Read Foreign Device 
  

Delete Foreign Device 
  

e MSTP Traffic   
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for BACnet Lookout V2.2 

BrightCore 

Bacnet Lookout 

Extended 2.2 

P/N BBLx-3 
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